
USER MANUAL
www.merging.com/Pyramix

Media Management & Libraries



ファイナル・チェック・メーター 
 

Pyramix ユーザーマニュアル 

 

ハウスキーピング 
Pyramix 上で多数の Media ファイルを扱う場合、Windows の階層的なファイル・システムは非常に煩雑で混乱し

ます。複雑なプロジェクトの作業では非常に多くのオーディオ・ファイルを使用するため、Pyramix では、Media ドラ

イブ/フォルダ，データベースおよびライブラリーという概念でプロジェクトの Media ファイルを管理します。 
Media Management タブ，EDL タブ，Libraries タブ，View ウィンドウ（Media > Search Results / Used 
Media / Media Present in Project Default Folder / Media NOT Present in Project Default Folder など）

からは、それぞれデータベースの操作や参照が行えます。 
  

Project Default MediaおよびNon Project Default MediaのViewウィンドウ、Search Resultsウィンドウは、そ

れぞれのウィンドウから目的に合わせてデータベースの参照が行えます。 
 

データベース 
データベースには、ライブラリーなどすべてのMediaリストに関する情報が保持されています。 
 
すべてのデータベースのデフォルト・パスは、Settings > All Settings > Application > Locationページの

Default Database Locationで設定することができます。 
 
特にパスを指定しない場合は、自動的にC:¥Documents and Settings¥<user name>¥Application 
Data¥Merging Technologies¥Pyramixへ設定されます。 

  
重要！データベースは、フリースペースが充分あるドライブへ設定してください。 
必要に応じて、より容量が大きく転送スピードが速いドライブへ変更することもできます。 

  

データベースの検索 
データベースのファイルは、Media ManagementタブまたはLibraryタブ上からシンプルなSQLiteベースのサー

チツールを使用して検索することができます。この時、サーチ・キーワードには、演算子（AND，OR，NOT），ワイ

ルドカード（*），括弧（）を組み合せることができます。 
 

データベ―スのロケーション設定 
Libraryデータベースのロケーション指定： 
Settings > All Settings > Application > Locationページ： “Default Database Location”設定 
z ロケーション・パスをタイプ入力するか、Browseボタンをクリックしてフォルダを参照してください。 
 
Fade Libraryのロケーション指定： 
Settings > All Settings > Application > Editingページ： “Fade Library Location”設定 

z ロケーション・パスをタイプ入力するか、Browseボタンをクリックしてフォルダを参照してください。 
z OKをクリックします。 
z Pyramixをリスタートします。 
z Libraryデータベースのロケーション・パスがアップデートされます。 
 

旧バージョンのライブラリー変換 
Pyramix v7のライブラリー・フォーマットは、それ以前のバージョンと下位互換がありません。 
旧 バージョンのライブラリーを開いた場合、自動変換されて新しいライブラリーが作成されます： 

z Pyramix v6より古いバージョンで作成されたライブラリーは、最初に開く際に自動変換されます。  
z オリジナルのライブラリーは、（.pml.6xx）としてバックアップされます。バックアップ・ファイルは名前を変更し

て、Pyramix v6（またはそれ以前のバージョン）で復元することができます。 
z コンバートされたライブラリーは、Pyramix v7のライブラリー（.pml）として置き換わります。 
z 新しくPyramix v7のライブラリー（.pml）が作成されると、それ以降はバックアップのライブラリー（.pml.6xx）の

内容は更新されません。 
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パフォーマンスについて 

データベースのロケーション 
データベースの最適なロケーションとして、SATA2（7200rpm）ディスクなどの速度の速いハードディスクの使用を

推奨します。また、OSやPyramixアプリケーションがインストールされているC:ドライブはパフォーマンスの低下を

避けるためにもデータベースのロケーションに使用することは避けてください。 
  

セーブ時間 
Pyramix v7においてハイパフォーマンスなディスク（SATA 7200rpmなど）を使用した場合、プロジェクトのセーブ

時間は速くなります。古いディスク（IDE，5400rpmなど）やOSがインストールされているドライブ（C:ドライブ）への

保存は、セーブ時間が減速するかもしれません。 
 
 

Mediaフォルダ 
Media Folderは、Mediaファイルを含んだハードディスク上のドライブもしくはフォルダを指します。Pyramixから

Mediaファイルへアクセスするには、Media Folderをマウントする必要があります。Media Folderをマウントすると、

Mono，Stereo，マルチチャンネルなどのMasterクリップが一覧表示されます。 
  

これらは、フォーマットの種類，サンプリングレート，ビット深に関わらず、Media Management画面からドラッグ＆

ドロップまたはコピー＆ペースト操作でタイムライン上への貼り付けやUserライブラリーへ保存が可能です。 
 

Mediaフォルダの同期 
PyramixにマウントされているMediaフォルダは、Mediaファイルが追加されたり変更があったりした場合など自動

的にWindowsフォルダと同期します。整合性に何らかの問題がある場合は、Mediaフォルダを選択してMedia 
Folder>Refresh Media Folderでリフレッシュを試してみてください。 

  
  

Mediaのターゲット設定 
Project > New または Project > New From Template からプロジェクトを新規作成する時に指定したメディ

ア・フォルダは、下記の場所においてもターゲットとして設定されます。 
 
z All Settings > Project > General設定 Project Media Folder 
z All Settings > Project > Record設定     Target Settings > Media Folder 
z Project > Renderメニュー  Target Settings > Media Folder 
z Project > Mix Downメニュー  Target Settings > Media Folder 
 
これらの設定は、後から個別に変更することが可能です。 
 
 

オーディション再生 
Media Management画面に表示されるマスタークリップやライブラリー画面のオーディオ・オブジェクトは、

Monitorセクションを介してオーディション再生することができます。任意のオブジェクトを選択して、ツール・バー

上のPlay/Stopアイコンやスペース・バー/ESCキーを使用すると、オーディション再生/停止が行えます。オーディ

ション再生中にオブジェクトをダブルクリックすること、再度スタート・ポイントから再生できます。 
 
“Media Manager&Libraryのモニタリング”の章もご参照ください。 
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ドラッグ＆ドロップ 
Pyramixと互換があるオーディオ・ファイルは、Windowsブラウザ画面からPyramixのライブラリーやタイムライン

上へ直接ドラッグ＆ドロップして使用することができます。また、iTunesなどのアプリケーションから1つまたは複数

のファイルをドラッグ＆ドロップして、Pyramixのタイムラインまたはライブラリーへドラッグ＆ドロップできます。 
 

例： 

Pyramixを起動してプロジェクトのLibraryタブを開きます。Windowsブラウザ画面から１つまたは複数のオーディ

オ・ファイルを選択して、Libraryタブ内へドラッグ移動します。選択したオーディオ・ファイルがPyramixと互換があ

る場合、ライブラリー（またはシェルフ）がハイライトするので、そのままファイルをドロップするとコピーされます。 
  

Note: その逆に、MediaファイルをPyramixのライブラリーからWindowsブラウザや他のアプリケーションへ

ドラッグ＆ドロップでコピーすることはできません。 
  

ドラッグ＆ドロップとProject Default Folder 
使用したいMediaファイルをWindowsブラウザからCtrlキーを押しながらPyramixのタイムライン上へドラッグ＆ド

ロップすると、Mediaファイルは自動的にProject Default Folderへコピーされます。何もキーを押さずにドラッグ

＆ドロップした場合は、そのMediaファイルのディレクトリがPyramixにマウントされます。 
 

Libraryタブへドラッグ＆ドロップ 

タイムライン上のクリップやセレクションは、Alt + Shiftキーを押しながらLibraryタブへドラッグ＆ドロップするとコピ

ーすることができます。 
  

データベースの参照 
Media Managementタブ，すべてのLibrariesタブ，Used Media，Project Default MediaおよびNon Project 
Default MediaのViewウィンドウ、Search Resultsウィンドウは、それぞれのウィンドウから目的に合わせてデー

タベースの参照が行えます。 
  

Media Managementタブ画面は、Windowsファイル・システムとPyramixのメディア・データベース間の主要なブ

リッジの役割を担います。 
 
 

Search 
PyramixではデータベースによるMediaファイルのサーチツールが備わっています。 
 

シンプルなサーチ 

Media ManagementタブまたはLibraryタブには、Searchボックスがあります。 

 
Searchボックスをクリックすると、ドロップダウン・メニューに検索履歴が表示されます。検索履歴をクリアしたい場

合は、ドロップダウン・メニュー内のClear Search Historyをクリックしてください。このオプションは検索履歴のみ

をクリアして、Searchボックスに入力中のキーワードはそのまま残ります。Searchボックスの右端にある×印をク

リックすると、キーワードをクリアします。 
  

データベースを検索するには、Searchボックスにキーワードを入力して、最後にEnterキーを押してください。 
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Global Searchボタンが点灯している場合、現在プロジェクトにマウントしているMediaフォルダとライブラ

リー内からキーワードをサーチします。ボタンが消灯している場合（Local Search）は、現在参照している

Mediaフォルダ/ライブラリー/シェルフ内からキーワードをサーチします。 
 
Global / Local Searchは、キーボードのWキーを押すことで切り替えることができます。 
または、タブ内のSearch > Search All Mounted Media Foldersメニューでも切り替えが行えます。 

 
Add to Search Resultsボタンを押すと、Search Results画面上に新しいフォルダを作成します。 
フォルダの名前はリネームすることができます。 
 
Add to Search Resultsは、キーボードのRキーを押すことで切り替えることができます。 
または、タブ内のSearch > Add to Search Resultsメニューでも切り替えが行えます。 
 
Search Results画面は、Media > Search Mediaメニューから開くことができます。 

  
  

Note: Global / Local Searchは、タブ画面によって以下のようにサーチ動作が異なります： 
  

z Media Managementタブにおいて、Global SearchはマウントされているすべてのMediaフォルダ内をサー

チし、Local Searchは現在参照しているMediaフォルダ内をサーチします。 
  

z Libraryタブにおいて、Global Searchは現在開いているすべてのライブラリー内をサーチし、Local 
Searchは現在参照しているライブラリー内をサーチします。 

 
z Search Results画面（Media > Search Mediaメニュー）でのサーチにおいて、Global Searchでは現在開

いているすべてのライブラリー内をサーチしてResultsフォルダを作成し、Local Searchでは現在参照してい

るライブラリー内をサーチしてResultsフォルダを作成します。 
  

z Used Media，Project Default Media，Non-Project Default Media画面でのサーチにおいて、Global 
Searchでは現在開いているすべてのライブラリー内をサーチしてResultsフォルダを作成し、Local Search
では現在参照しているライブラリー内をサーチしてResultsフォルダを作成します。 

  
z SearchボックスからMediaファイルのサーチを行うと、サーチ・キーワードがドロップダウン・メニューに検索

履歴として追加されます。前回と同じキーワードでサーチしたい場合などに便利です。検索履歴をクリアした

い場合は、ドロップダウン・メニュー内のClear Search Historyをクリックしてください。 
 
z サーチした結果は、Search Results画面へ保存されます。Search Results画面は、Media > Search 

Mediaメニューから開くことができます。詳細は後述の“Search Results”のページを参照してください。 
  
  

ドラッグ＆ドロップ 

 サーチ結果として表示されたアイテムは、他のライブラリーやタイムライン上へドラッグ＆ドロップできます。 
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Searchリクエスト（Syntax） 
Searchボックスでの検索は、フルテキスト検索（FTS3）に基づいたインターネット検索エンジン（Syntax）と同じ要

領で行えます。サーチ・ワードをすべて入力するか、キーワードを入力してサーチを行ってください。 
  

サーチ・キーワードには演算子（AND，OR，NOT），ワイルドカード（*），括弧（）を組み合せることができます。 
  

z “car”でサーチした場合、以下のようなアイテムが見つかります： 

 "AUTO CHEV VINTAGE CAR" 
"FORD EXT POWER DOOR LOCK ENGAGE SPORT_CAR" 
"FORD INT DOOR OPEN SLOW SPORT_CAR" 
"Horn_Car_ Passing" 
"Sticky Car Door_ Ope" 

z “car door”でサーチした場合、以下のようなアイテムが見つかります： 

 "FORD EXT POWER DOOR LOCK ENGAGE SPORT_CAR" 
"FORD INT DOOR OPEN SLOW SPORT_CAR" 
"Sticky Car Door_ Ope" 

z “Car door NOT lock”でサーチした場合、以下のようなアイテムが見つかります： 

 "FORD INT DOOR OPEN SLOW SPORT_CAR" 
"Sticky Car Door_ Ope" 
 
（"FORD EXT POWER DOOR LOCK ENGAGE SPORT_CAR"は除外されます） 

z “car wind*”でサーチした場合、以下のようなアイテムが見つかります： 

 "FORD INT WINDOW OPEN, SPORTS CAR" 
"FORD EXT WINDSHIELD WIPERS_CAR" 
"Car Automatic - Windscreen Wiper1" 

z “car OR auto”でサーチした場合、以下のようなアイテムが見つかります： 

 "AUTO CHEV VINTAGE CAR" 
"FORD EXT POWER DOOR LOCK ENGAGE SPORT_CAR" 
"FORD INT DOOR OPEN SLOW SPORT_CAR" 
"Horn_Car_ Passing" 
"Sticky Car Door_ Open" 
"04 Auto Old" 
"5031 AUTO_NISSAN, TRUCK, SUV" 

また、ワイルドカード " * " を使用したサーチも行えます。 

z “*unch”でサーチした場合、以下のようなアイテムが見つかります： 
 "munch" 

"punch" 

ただし、ワイルドカード（*）は他のAND，OR，NOTと同時に使用することはできません。 
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その他のリクエスト： 
z “Name:car” 
 Mediaファイル名が“car”のみのアイテムを検出します。※後述参照 

z “Format:Wave” 
 Waveフォーマットのみを検出します。 

z “(car OR auto) AND (door OR wind*) NOT lock” 
 名前に“car”または“auto”および“door”または“wind*”を含み、“lock”を含まないアイテムを検出し

ます。 

  

Mediaファイル名& Masterクリップのファイル名 

デ フォルトではMasterクリップとMediaファイル名の両方から“Car”をサーチします。 

z Mediaファイル名のみにサーチ結果を限定するには、キーワードに“NAME:Car”と入力します。 

z Masterクリップ名のみにサーチ結果を限定するには、キーワードに“FileNane:Car”と入力します。 
 

 

Search Results 

 
  

サーチした結果は、Search Results画面へ保存されます。 
  

Search Results画面は、Media > Search Mediaメニューから開くことができます。 
 
ここに保存されているサーチ結果は、選択してタイムラインや他のライブラリーへ追加することができます。 
また、新たにSearch Resultsフォルダを作成して編集も行えます。 
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Media Management（メディア・マネージメント） 
Mediaメニュー 

このメニューは、現在のプロジェクトに関連するメディアの管理を行います。 
  

Search Media Search Resultsウィンドウを開きます。 

－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－

Mount Referenced Media 現在のプロジェクトで使用しているメディアをすべてマウントします。 

Auto-Mount Media 選択すると、オフラインのライブラリーを参照して現在のプロジェクトへ使用した

際に、メディアを自動でマウントします。 

－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－

Select Online Clips タイムライン上で現在MediaがマウントされているOnlineクリップをすべて選択し

ます。 

Select Offline Clips タイムライン上で現在MediaがマウントされていないOfflineクリップをすべて選択

します。 

－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－

Select Used Media プロジェクト上で選択したクリップのMediaファイルの場所をMedia Manager画
面で開きます。 

Select Media present on 
Project Default Folder 

現在のプロジェクトでProject Default folderから参照しているメディアを

Composition Library画面を開いてハイライトで示します。 

Select Media NOT present on 
Project Default Folder 

現在のプロジェクトでProject Default folder以外のフォルダから参照しているメ

ディアをComposition Library画面を開いてハイライトで示します。 

－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－

Collect Media to current 
Project Default Folder 

Project Default folder以外のフォルダから参照している（Select Media not 
present ... メニューで検出した）Mediaファイルを、すべてProject Default 
folderへコピーします。この機能は、別のスタジオへディスクを移動して作業をし

たり、ネットワーク上のリソースを使用したりする場合に便利です。 

－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－

Clean-Up Media Choose a Media Folder to Clean-Upウィンドウが開きます。クリーンアップし

たいMediaフォルダを選択し、OKしてください。現在のプロジェクトで使用されて

いないMediaファイルがMediaフォルダ内からすべて削除されます。 
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Media Management & Libraryタブ画面 
Media Management & Libraryタブのコラム 

Media Managementタブ，Libraryタブ，Search Results画面に表示されているコラムは、タブ内のView > 
OptionsメニューからColumnsダイアログを開いて表示内容を設定することができます。 
 

コラムの配列 

 コラムの配列は、各列のヘッダー部分をクリック＆ドラッグして並べ替えることができます。 
  

コラムの並べ替え 
コラムの表示は、各列のヘッダー部分をクリックすると数字またはアルファベット順に並べ替えることができます。

クリックする毎に昇順/降順が切り替わります。 

  
View > Options Columnsダイアログを開きます： 

  
Columnsダイアログには、Available ColumnsとShown Columnsの２種類のリストが表示されています。 

  

Available Columns のボタン： 

Add 選択したコラムをShown columnsリストへ追加します。 

Add All すべてのコラムをShown columnsリストへ追加します。 
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Shown Columnsのボタン： 

Remove 選択したコラムをShown columnsリストから削除します。 

Remove All すべてのコラムをShown columnsリストから削除します。 

Apply to Folder このダイアログで変更した内容を、現在参照しているフォルダへ適用します。 

Apply to library このダイアログで変更した内容を、現在参照しているライブラリーのすべてのフォル

ダへ適用します。 
Set as Default このダイアログで変更した内容を、現在参照しているライブラリーのすべてのフォル

ダへデフォルトとして設定します。 

  

コラム： 

Name クリップまたはMediaファイルの名前 

Category カテゴリー分類  例：Master Clip, Media Folder など 

Notes ノート 
Creation Date クリップまたはMediaファイルの作成日 
Author 作成者 

In クリップまたは Media ファイルの In TimeCode 

Out クリップまたは Media ファイルの Out TimeCode 

Duration クリップまたは Media ファイルの長さ 

Sample Rate クリップまたは Media ファイルのサンプルレート 

Frame Rate （Media のみ） Media ファイルのフレームレート 

Track クリップまたは Media ファイルのトラック数 

BPS ビット深 

Format ファイル・フォーマット  例：PMF, WAV など 

Automated Object  

Mixer Snapshot Mixer のスナップショット 

FileName （Media のみ） Media ファイルの名前 

Media File Name  
（Mediaのみ） 

Mediaファイルのサイズ（単位：byte） 

Scene シーン 

Take テイク 

Tape テープ 

UBITS  
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トリマー 
Media Management および Libraryタブ画面には、Composition/Media Trimmerエリアがあります。 
 

 
 

トリマーは、Trimmer > Showメニューにより表示／非表示を設定できます。リスト内でMediaファイル（またはオ

ブジェクト）を選択するとトリマーが表示され、オーディション再生やトリム編集を行うことができます。各トラックの

左側に表示されている小さな■表示は、トリマー再生におけるミュートOn/Offボタンです。 
 
Mediaファイルが2chの場合、トリマーの出力はステレオになります。Mediaファイルがペアではない2ch以上の場

合、モノラル出力にまとめられてモニターチャンネルの両側から出力されます。 
 
左上の ? マークをクリックすると、トリマーに対するコマンド・リストが表示されます。（下図参照） 
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Mediaファイル，クリップ，コンポジションは、以下の方法でトリム編集を行えます。 

  
ダブルクリック Monitorセクションを介して、ダブルクリックした位置からオブジェクトの再生

できます。 が 
Note: 再生してもモニター出力が聞こえない場合は、Monitorセクショ

ン内のConfigureページにて設定を確認してください。 
 
“Media Manager&Libraryのモニタリング”の章もご参照ください。 

Click & ドラッグ トリマー上で編集したオブジェクトを、タイムラインまたは他のライブラリー内

へペーストします。（リスト上からドラッグした場合、トリム編集の影響なく全

体をペーストします） 

Shift + クリック クリックした位置にTrim Inポイントを設定します。 
設定したポイントは、クリック＆ドラッグで簡単に修正できます。 

Ctrl + クリック クリックした位置にTrim Outポイントを設定します。 
設定したポイントは、クリック＆ドラッグで簡単に修正できます。 

Ctrl + Shift + クリック クリックした位置にSyncポイントを設定します。 
設定したポイントは、クリック＆ドラッグで簡単に修正できます。 

Shift + Alt + クリック クリックした位置にTrim Inポイントを設定し、そこから再生します。 

Ctrl + Alt + クリック クリックした位置にTrim Outポイントを設定し、そこから再生します。 

Ctrl + Shift + Alt + クリック クリックした位置にSyncポイントを設定し、そこから再生します。 

Ctrl + ダブルクリック Trim In/OutポイントおよびSyncポイントをリセットします。 

  
  

Trim In, Trim Out および Syncポイント 
Trim In/OutポイントおよびSyncポイントは、Media Management画面でMediaフォルダのリフレッシュや次回の

マウントが行われるまで、Masterクリップの情報として保持されます。 
 

旧バージョンとの互換性 

MediaトリマーのTrimmer In/OutやSyncポイントの設定を含め、現在のライブラリーはタブ内の Library > Save 
Library as 5.x 6.0 または Library > Save Library As 4.x メニューからSave asすることで旧バージョンと最

大限の互換性をもたせることができます。 
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Media Managementタブ画面 
Media Managementタブ画面は、Document LibraryおよびGlobal Libraryタブ画面とほぼ同様の操作と表示

になっています。ただし、タブ内のメニューとツール・バーの内容は多少異なります。 
 

Media Managerの履歴 
Media Managerのデータベースと履歴は、以下の設定によりPyramixをシャットダウンまたは再起動した場合でも

保持されています。（デフォルト） 
  

Settings > All Settings > Application > General > ‘Keep Media Manager History’ 
  

このオプションのチェックが外れている場合、履歴はリセットされます。（Media_Library_.pmlファイルは、次回

Pyramixが起動する際にスクラッチから再構築されます。） 
  

このオプションは、複数のユーザーが同一のデータベースで異なるプロジェクトを作業する場合などに便利です。 
  
  

Note: このオプションが無効な場合、Media_Library_.pmlファイルは最小サイズにとどまりますが、Pyramix
を起動した際にマウントの時間が長くなります。 

 
 

Media Browser 
Media Managementウィンドウは、Media Browserとしてローカルまたはネットワーク上のMediaフォルダを参照

できます。 

 
  

Media Browser は、Mounted Media Folders の下にツリー構造でディレクトリを表示します。 
  

Media Browser上で認識したMediaファイルは一時的にマウントされ、オーディション再生やタイムラインへの貼り

付けが行えます。 
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Media Managementタブ・メニュー 

Media Folderメニュー 

Mount Media Folder 任意のMediaフォルダを参照して、マウントします。Mediaフォルダをマウントする

と、Pyramix上からMediaファイルを参照することができます。 

Unmount Media Folder 指定したMediaフォルダをアンマウントします。Mediaフォルダをアンマウントする

と、Pyramix上からMediaファイルを参照できなくなります。 

Refresh Media Folder Mediaフォルダを最新の情報に更新します。F5キーを押すと、選択しているMedia
フォルダの表示内容を最新の情報に更新します。 

Clear Media Manager 
History 

Media Manager の履歴情報をクリアして、データベースのサイズとパフォーマンス

を改善します。 

－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－

Create Offline/Reference 
Library 

後述の“Offline/Referenceライブラリーの活用”のページをご参照ください。 

Create Quick Mount 
Libraries 

__QuickMount.pml' という名前のQuickMountライブラリーを作成します。これによ

り、次回プロジェクトを開く際にMediaファイルをマウントする時間が短縮されます。 

－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－

Open Folder リスト内で選択したドライブまたはサブ・ディレクトリを展開します。 
または、表示されているMediaフォルダの名前をダブルクリックしてください。 

Up One Level 1つ上の階層へ移動してリストを表示します。 

－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－

Mounting Rules Mounting Rulesダイアログを開きます。後述の“Mountingルール”のページをご

参照ください。 
Properties 選択したMediaフォルダのプロパティを表示します。 

 

Editメニュー 

Copy オブジェクトをコピーします。 

Paste with Media コピーしたオブジェクトを関連するMediaファイルと一緒にペーストします。 

Rename オブジェクトをリネームします。 

Lock Rename オブジェクトのリネーム操作をロックします。 

－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－

Open/Audition 
 

選択したクリップまたはコンポジションをトリマー内で開き、オーディション再生しま

す。または選択したShelfを開きます。 

Audition 選択したMasterクリップをトリマー内で開き、オーディション再生します。 

Stop Audition オーディション再生をストップして、カーソルを先頭へ戻します。 
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Place (Ctrl + P) Placeダイアログを開きます： 

 
選択したオブジェクトは、ここで選択したルールに従ってタイムライン上にペーストされます。 
選択したオブジェクトのSyncポイントまたはInポイントの位置を、タイムラインで選択したトラックのPlayカーソル

の位置にペーストします。 

Placement Tool オブジェクトをペーストするためのPlacement Toolダイアログを開きます。 
詳しくは、“Placementツール”のページを参照してください。 

－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－

Locate 選択したオブジェクトが使用されているタイムライン上のクリップの先頭へPlayカー

ソルをロケートします。 

Show Usage 選択したオブジェクトが使用されているタイムライン上のクリップ全体をズーム表示

します。 

－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－

Delete Media 選択したMasterクリップと関連するMediaファイルをハードディスク上から削除しま

す。 
 
※このコマンドで削除したMediaファイルは元へ戻せません。 
また、関連する波形ファイルも同時にドライブ上から削除されます。 

Collect Selected Media to current Project Media Folder 
 

Selectメニュー 
Select All リストに表示されているオブジェクトをすべて選択します。Ctrlキーを押しながらクリ

ックすると、複数のオブジェクトを個別に選択できます。 

Invert Selection オブジェクト選択の対象と非対象を入れ替えます。 

－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－

Select Media Present on 
current Project Media 
Folder 

Project Media Folderに存在（保存）しているMediaファイルを選択して表示します。

Select Media NOT present 
on current Project Media 
Folder 

Project Media Folderに存在（保存）していないMediaファイルを選択して表示しま

す。 
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Convertメニュー 

Quick Import ハードディスク上のサウンド・ファイルをオリジナル・フォーマットまたはPMFフォーマ

ットへコンバートしてインポートします。 
 

Note: Pyramixがサポートするオーディオ・フォーマットのサウンド・ファイをイン

ポートする場合はコンバートする必要はありません。 

Quick Export PyramixのMasterクリップを、フォーマット変換してエキスポートします。 

 

One file per track チェックすると、マルチチャンネルのMasterクリップをチャンネル別のシングル

ファイルに分割してエキスポートします。 

Simple file numbering 
(.1, .2, .3, ...) 

チェックすると、エキスポートしたファイルに昇順にナンバーを追加します。 
このオプションは‘One file per track’と連動します。 

Flatten track numbers チェックすると、エキスポートしたファイルに昇順にトラック・ナンバーを追加し

ます。 

Unique filename extension チェックすると、ファイル名の重複を防ぐためにエキスポートするMediaファイ

ルの名前にランダムに数字を追加します。 
 

Quick Convert > 選択したMediaファイルを様々にコンバートします。 
後述の“Convert - Quick Convertサブ・メニュー”を参照してください。 

－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－

Sample Rate Conversion Mediaファイルのサンプルレートを変換します。後述を参照してください。 

－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－

Reverse 選択したMediaファイルをコンバートして逆再生ファイルを作成します。 
－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－

Export XML Description 選択したMediaファイルに関する詳細をXMLファイルとしてエキスポートします。 

Export to MTInterchange XML 

－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－

Publish to Open External Database 
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Viewメニュー 
Viewメニュ  ーでは情報をどのように表示するかを決定します。 

Status Bar ステータス・バーの表示をOn/Offします。 

－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－

Large アイコンを大きく表示します。 

Small アイコンを小さく表示します。 

List リストで表示します。 

Detail 詳細リストで表示します。 

－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－

Options Columnsダイアログを開きます： 

 
Columnsダイアログには、Available ColumnsとShown Columnsの２種類のリストが表示されています。 

 

Available Columnsのボタン： 

Add 選択したコラムをShown columnsリストへ追加します。 

Add All すべてのコラムをShown columnsリストへ追加します。 

Shown Columnsのボタン： 

Remove 選択したコラムをShown columnsリストから削除します。 

Remove All すべてのコラムをShown columnsリストから削除します。 

Apply to Folder このダイアログで変更した内容を、現在参照しているフォルダへ適用します。 

Apply to library このダイアログで変更した内容を、現在参照しているライブラリーのすべての

フォルダへ適用します。 

Set as Default このダイアログで変更した内容を、現在参照しているライブラリーのすべての

フォルダへデフォルトとして設定します。 

－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－

New Window Media Managementタブ画面を一時的に別画面で開きます。 
Refresh 表示を最新の情報に更新します。 
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SACDメニュー 

 
  

DST Encoder Edited MasterのDSTエンコードを実行します。 

 

DST Estimator Edited MasterのDSTエンコード化を見積もります。 
ファイルサイズと軽減率をグラフ表示と共に示します。 

Annex D.3 Verification 

 

Trimmerメニュー 

 
  

Show 
Show On トリマーを表示させます。 
Show Off トリマーを非表示にします。 

Auto-Show Mediaファイルを選択すると自動的にTrimmerを表示する設定です。 

－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－

Don’t Show too Large 
Media/Compositions 

チェックすると、大きいMediaファイルおよびコンポジションをトリマー内に表示

せません。 さ 
Note: 選択したMediaファイルまたはコンポジションが16トラック以上ま

たは100個以上のクリップだった場合、トリマー内に表示させません。これ

により、不要な読み込み時間を回避します。 

Show 1 Track Trimmerにオブジェクトの最初のトラックのみ表示します。このオプションを 
選択すると、Trimmerトラックの左側に上下矢印（▲/▼）が表示され、トラッ 
ク表示の移動を行うことができます。 
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Show Track Details 選択されたMediaファイルのトラック情報について、以下を表示します： 
z Track Name 
z Track Number 
z Track Type（left, Right, Center など） 
z Track File Name （One File Per Trackモードで録音したメディアのみ対応）

－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－－

Auto-Generate Waveform オブジェクトを選択した時に自動的に波形生成を行って、Trimmer を表示します。

  

Media Browserメニュー 

Mount Currently Displayed 
Media Folder 

Media Browserで参照している任意のMediaフォルダをマウントします。 
（Media Managementタブの左側のツリー内にある）Media Browserから任意のフ

ォルダを選択して、このメニューを選択してください。 

  

Searchメニュー 

Search All Mounted Media 
Folders 

Global / Local Searchを切り替えます。または、キーボードのWキーを押すこと

で切り替えることができます。 
 
Global Searchボタンが点灯している場合、現在プロジェクトにマウントしている

Mediaフォルダからキーワードをサーチします。ボタンが消灯している場合（Local 
Search）は、現在参照しているMediaフォルダ内からキーワードをサーチします。 

Add to Search Results Search Results画面上に新しいフォルダを作成します。Search Results画面

は、Media > Search Mediaメニューから開くことができます。 
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Convert - Quick Convertサブ・メニュー 

 
  

Outputダイアログ 

 
  

Quick Convertメニューの変換オプションを実行すると、新しいMediaファイルが作成されます。変換オプションを

選択すると、上図のダイアログがオプションの内容に応じて表示されます。 
 
ラジオボタンでコンバート後のファイル名に新しい名前付ける（New name）か、既存のファイル名にテキストを追

加するか（Add Suffix）を選択してください。複数のファイルに一回のオペレーションで名前を付けたい場合は、

Add Suffixボタンを選択してください。 
 
Keep Original File Formatにチェックを入れると、ファイル・フォーマットをオリジナルに保ったままコンバートを実

行します。Properties...ボタンをクリックすると、各コンバートの内容に応じたダイアログが開き、オプション設定が

行えます。（下記を参照してください） 
 
複数のファイルをファイルごとにパラメーターを変更しながらコンバートしたい場合は、OKを選択します。 
複数のファイルを選択している場合は、最後にOK Allボタンをクリックすると一括コンバートが開始します。 
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Quick Convert - Propertiesダイアログ 
Resampler Properties 

 
  

このモジュールは、基本的に±0.1％プルアップ/プルダウンのオーディオ変換を行うために使用しますが、定義の

方法（フレームレート，サンプルレート，ピッチおよび％レシオ）によって、多目的にも使用できます。 
  

このプロセスではピッチが変更されるのでタイムストレッチの操作とは異なります。入力ファイルと出力ファイルは

同じサンプリングレートですが、出力ファイルは長さが異なります。（入力ファイル×レシオの％＝出力ファイル） 
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Qualityの設定は、オーバーサンプリング処理のトリートメント効果に関する選択です。 

  
下のグラフは、Quality設定におけるTHD+Nをあらわしています。 
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Prosoniq MPEX3 のプロパティ 

 
z Stretch または Pitch のオプションの中から必要な設定を選んでください。 

  
z Quality Mode および Formant Type の中から適当な設定を選び、MPEX3 Settingsを最適化してくださ

い。 

z MPEX3 Settings： 

Quality Mode Single Instrument Fast 

Single Instrument Best 

Polyphonic Fast 

Polyphonic Good 

Polyphonic Best 

Formant Type Sung Voice 

Spoken Voice 
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TimeZone のプロパティ － Basicタブ 

 
z Scaling は、タイムストレッチの長さを％入力またはスライダーを使用して設定します。 
 
z Quality は、スライダーを使用してHigh Quality（High） および Fast processing（Fast）の間で調整できま

す。 
  

z Stereo Processing は、ステレオのメディアをアナライズする場合の選択です。 
“Enabled”ボックスをチェックすると、設定が有効になります。 

 
 

TimeZone のプロパティ － Presetsタブ 

 
 

ドロップダウンリストは、様々なサウンドタイプに合わせたアルゴリズムのプリセット選択を提供します。 
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TimeZone のプロパティ － Advancedタブ 

 
これらのパラメーターは、素材が馴染むようにするための微調整を行います。 

  
Blocklength ブロック長を32～2048の間で調整できます。 

テキストボックスへ値入力を入力するか、スライダーを移動してください。 

Crossfading スライダーの移動によってブロック間のクロスフェードの長さを調整できます。 

Energy Detection Enableのボックスにチェックを入れると、-70dB～0dBの間でスレッショルドレベル

値を設定できます。テキストボックスへ値入力を入力するか、スライダーを移動し

てください。 

 
 

Normalize のプロパティ 
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Level dBfs 4つのプリセットから値を選択するか、スライダーを使用して新しいファイルの最大

値を設定します。 

Group Normalize チェックすると、グループのどのクリップも最大のピークレベルまで引き上げられ、

他のクリップと比例したレベルの増加を行います。 

DC Removal チェックすると、D.C.オフセットが削除されます。 

  
  

Wordlength Converter のプロパティ 

 
  

Destination Wordlength ラジオボタンを使用して、希望するワード長を選択します。 
Noise Shaping ノイズ・シェーピングのクォリティを選択します。 

¾ Hi-Pass 
¾ 8th Order 
¾ 49th Order 

DC Removal チェックすると、D.C.オフセットが削除されます。 

  
高音質な設定にした場合、処理時間がかかります。 

  
Dithering にチェックすると、ディザリングが適用されます。 

  
  

Samplerate Conversion （サンプルレート変換） 
プロジェクトと異なるサンプリングレートのMediaファイルに対して高音質なサンプルレート変換を提供します。 

Merging Technologies社はHeptaConサンプルレート・コンバーターを使用しています。 
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ラジオボタンでコンバート後のファイル名に新しい名前付ける（New name）か、既存のファイル名にテキストを追

加するか（Add Suffix）を選択してください。 
 
Keep Original File Formatのチェックボックスを選択すると、ファイル・フォーマットが保たれます。チェックしない

場合、SRCコンバートしたファイルはPMFフォーマットで保存されます。 
  

Properties... 
Properties...を選択すると、HeptaCon SRC module Propertiesダイアログが開きます： 
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Data Format 
ラジオボタンでPCMまたはDSD 64を選択します。（DSD64は、DXDコンバートを行う場合に利用できます） 

  
Sampling Rate Conversion 
 
Output SR ドロップダウンリストから出力するサンプリングレートを選択します。 

Filter Type Lin. Phase，Min Phase，Apodizingの3種類からフィルターを選択できます。 

Quality コンバートのクォリティは、デフォルトでVery Highに設定されています・ 
  

Dithering 
Enable チェックすると、ディザリングが有効になります。 
Requantization ドロップダウンリストから幅広くビットレートを選択できます。 
Noise Type デフォルトはTPDFです。 
Noise Shaping High Pass（POW-r2）またはEqual Loudness（POW-r 3）を選択します。 

  
OK 
設定の変更を適用してダイアログを閉じます。 

  
Cancel 
設定の変更をキャンセルしてダイアログを閉じます。 
 
Apply 

 設定の変更を適用します。 
  
  

 コンバートの実行 

複数のファイルをファイルごとにパラメーターを変更しながらコンバートしたい場合は、OKを選択します。 
複数のファイルを一回のオペレーションですべてコンバートしたい場合は、OK Allを選択します。 
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